26 05 76 - Arc-Flash Studies

1. Introduction
   
   A. Arc-Flash Studies are utilized to assist qualified personnel in identifying the hazards associated with electrical equipment. Duke University requires Arc-Flash Studies for equipment rated 208 VAC and higher likely to require service or inspection while energized. This guideline is for existing systems, the expansion and modification to existing systems, and new construction.

2. Objective
   
   A. Perform an Arc-Flash Study of the electrical distribution system using the IEEE 1584 methodology. Use Power*Tools for Windows (PTW) software from SKM Systems Analysis, Inc. to conduct this study.

   B. Scope shall include at a minimum:
      i. field verify accuracy of electrical system information
      ii. collect additional electrical system information as needed
      iii. produce a detailed report of findings/recommendations
         a. draft pre-mitigation report
         b. final pre-mitigation report
      iv. complete a detailed short circuit fault current analysis
      v. complete a detailed coordination analysis
      vi. complete a detailed arc-flash risk assessment
      vii. produce floorplans showing location of major electrical equipment
      viii. produce up-to-date single-line diagrams (SLDs)
      ix. produce/apply arc-flash hazard labels
      x. provide electronic copy of all deliverables

   C. Scope may also include:
      i. produce an asbuilt post-mitigation report *(typically under separate contract after recommended remediation items have been completed)*

3. References
   
   A. NFPA 70E: Standard for Electrical Safety in the Workplace
   C. IEEE 1584.1-2013: Guide for the specification of Scope and Deliverable Requirements for an Arc-Flash Hazard Calculation Study in Accordance with IEEE Std 1584
   D. IEEE C37.20.7: Guide for Testing Metal-Enclosed Switchgear rated up to 38 kV for internal arcing faults
4. **Acronyms**

   AFB – Arc-Flash Boundary
   AFIE – Arc-Flash Incident Energy
   ATS – Automatic Transfer Switch
   DUES – Duke Utilities and Engineering Services
   FMD – Facilities Management Department
   MCC – Motor Control Center
   OCPD – Over Current Protection Device
   SLD – Single-Line Diagram
   UPS – Uninterruptible Power Supply
   VFD – Variable Frequency Drive

5. **Information/Resources Supplied by Duke**

   A. Available 3-Phase and Single-Line-Ground fault currents and associated X/R ratios at the service entrance location (utility source)
   B. Single-line diagrams (as available)
   C. Floorplans (as available)
   D. Assistance during field verifications / Personnel knowledgeable of electrical system
   E. Direction on mitigations to be included in final (pre-mitigation) and as-built (post-mitigation) reports
   F. Direction as to how/where labels are to be applied
   G. CustomLabel.dat file with Duke SKM Label Templates
6. Performance and Installation Requirements

A. Field verify all equipment in the electrical system (starting at the service disconnect), equipment types, cable types, protective device types and settings. The level and accuracy of detail regarding the existing infrastructure shall be investigated prior to submission of proposal. For safety purposes, a preliminary study shall be performed to estimate the hazards of all equipment prior to exposure of any energized components. Once the preliminary study is complete, all equipment shall be accessed and any unlabeled circuits traced, as needed, by Duke University personnel only.

B. During the course of field investigations, un-named equipment to be included with the study shall be given a logical identifying name for creation of the single-line diagram. The equipment shall be legibly marked with its identifying name during field investigations for later reference prior to final labeling. See Figure C for SKM nomenclature guideline.

C. Provide a 1-hr. training session to present the findings of the associated study.

D. Provide and apply final pre-mitigation labels to all equipment associated with the arc-flash study within 30 days of acceptance of report. Labels shall be suitable for the environment for which they are installed. For example, labels installed on outdoor equipment shall be weather and UV resistant.

E. Provide and apply asbuilt post-mitigation labels to all equipment affected by remediation measures completed within 30 days of acceptance of report. Obsolete labels previously applied shall be completely removed.

F. Photographic Records

i. During the course of field investigations, capture and provide suitable photographs of each piece of equipment included within the SKM model to represent:

   a. Overall view of equipment (only to the extent possible avoiding exposure to energized parts)

   b. Equipment designation/nameplate

   c. Breaker position and trip rating (where applicable)

   d. Adjustable breaker settings (where applicable)

   e. Arc Flash & Hazard labeling (where applicable)
7. **Detailed Report Requirements**

**A. Format**

i. Cover (to include both building number and building name)

ii. Modification Log Sheet

iii. Executive Summary

   a. Background / Calculation Means and Methods
   
   b. Brief Summary of Existing Conditions / Missing Information / Assumptions
   
   c. Brief Summary of Recommendations
   
   d. Table of Recommended Remediation (Duke template)

iv. Input Data Report *(in PDF format only, do not include in Hard Copy)*

v. Short Circuit Fault Current Analysis/Recommendations

vi. Coordination Analysis/Recommendations

   a. Existing Time-Current Curves
   
   b. Recommended Time-Current Curves

vii. Arc-Flash Risk Assessment/Recommendations

viii. Floorplans (Ledger Sized, 11 inch x 17 inch)

ix. Input and Output Single-Line Diagrams (Ledger Sized, 11 inch x 17 inch)

x. Arc-Flash Labels

**B. Short Circuit Fault Current Analysis**

i. Complete a detailed analysis of each piece of equipment in the system and report any deficiencies and/or recommended corrections/improvements.

ii. The system shall be modeled in all operating modes [i.e. normal, emergency (if applicable), bypass (if applicable)]. Report shall also indicate the maximum available fault current from all operating modes.

iii. Emphasis shall be placed on equipment exceeding its interrupting rating by more than 110%.
C. Coordination Analysis

i. Complete a detailed device coordination analysis of the electrical system and report any deficiencies, concerns and/or recommended corrections/improvements.

ii. The first building protective device shall coordinate with closest upstream High Voltage protective device.

iii. Provide both existing and recommended time-current curves. A partial one-line diagram of the associated devices shall be attached to each time-current curve. Curves shall be in color and contain the following protective device information: Component Name, Manufacturer, Type, Frame/Model, Sensor/Trip, Plug and Settings. Adequate equipment protection should also be evaluated.

iv. Recommendations for coordination improvement shall also indicate the affect to downstream AFIE.

D. Arc-Flash Risk Assessment

i. Complete a detailed arc-flash risk assessment of each piece of equipment in the system and report any deficiencies and/or recommended improvements.

ii. Emphasis shall be placed on equipment that has an Incident Energy greater than 8 cal/cm².

iii. The system shall be modeled in all operating modes [i.e. normal, emergency (if applicable), bypass (if applicable)]. Report shall also indicate the maximum available arc-flash rating from all operating modes.

E. Floorplans

i. Produce scaled floorplans in AutoCAD format that indicate the location of all major equipment. Floor plans shall be printed on ledger sized (11 inch x 17 inch) pages with matchlines and page numbers to other pages as required. Provide keyed plan to indicate plan location within the associated floor (as needed).

ii. Floorplans shall have a title block designating building number, building name, and drawing number at a minimum.

iii. For Arc-Flash studies of new construction and renovation projects, the Architect is responsible for providing floor plans to the consultant team conducting the Arc-Flash study.

iv. Minor updates to floorplans shall be included in this scope to correct any discrepancies observed in the mechanical and electrical rooms.
F. Single Line Diagrams (SLDs)

i. SKM single-line diagrams shall be exported to AutoCAD format and printed on ledger sized (11 inch x 17 inch) pages with references to other pages as required. Provide keyed plan to indicate page location within the diagram.

ii. SLDs to include building number, building name, and drawing number.

iii. Separate diagrams shall be provided for input and output data.
   a. Refer to Figure B for Duke FMD SKM one-line datablock formats.
   b. Refer to Figure C for Duke FMD SKM nomenclature guideline
   c. Refer to Figure D for sample Input and Output one-lines.

G. Equipment Labels

i. Arc-flash labels shall be provided for and applied to the following equipment rated 208 VAC and higher likely to require service or inspection while energized (both front and rear entry – if applicable):
   a. Metal-Clad Switchgear:
      1. Incoming section—line-side of main
      2. Branch feeder sections—load-side (ONLY IF the worst case incident energy at line-side is greater than 8 cal/cm² AND the equipment meets ANY of the following criteria):
         a. Equipped has an “arc-resistant” barrier built in compliance with ANSI/IEEE C37.20.7 standard that can insure that the dangerous power of the higher line-side incident energy from the incoming section will not migrate to the adjacent feeder section.
         b. A qualified person with the skills and knowledge of electrical equipment construction confirms the presence of a complete barrier between the line-side connections and the possible location of an arc-flash in the adjacent feeder section. [C]
   b. All other Switchgear, Switchboards, Panelboards, Industrial control panels, Meter socket enclosures, VFD’s, ATS’s, Machine control panels, MCC’s, Contactors, UPS’s, Busway(s), and Bus plugs
      1. Incoming section—line-side of main (if equipped)
   c. Three-Phase Mechanical and Equipment Disconnect— Fused and Non-Fused
      1. Incoming section—line-side of fuse (if equipped)
ii. Labels shall indicate at a minimum:
   a. Nominal Voltage (Shock Hazard)
   b. Arc-Flash Boundary
   c. Available Incident Energy (cal/cm²) & Working Distance
   d. Site Specific PPE Level
   e. Available Fault Current (Isc)
   f. Glove Class
   g. Limited Approach Distance
   h. Restricted Approach Distance
   i. Building ID Number (Bldg #)
   j. Company Identification (prepared by)
   k. Date Label Prepared

iii. See Figure A for label examples and Avery Template Numbers. Prior to the application of the labels, clean the area to which the labels will be applied. Source feed labels will be provided by Duke University personnel at the time of label application (as needed).
8. SKM Analysis

A. Equipment below 240 volts need not be considered unless it involves at least one 125 kVA or larger transformer as its immediate power supply [B]. This direction refers to incident energy calculations only. All equipment operating at 50 volts and higher in the facility shall be assessed for other possible electrical dangers such as shock and overload conditions. Within SKM, utilize options under menu Arc Flash – Study Options -> Standard and Unit; select “<240 V” and “Report as Category 0 if Transformer Size < 125kVA” to provide labels compliant with the Duke University SKM labeling nomenclature guideline.

B. Utilize a maximum arcing time of 2 seconds for incident energy calculations as is acceptable to NFPA 70E, IEEE 1584 and Duke FMD. Sound engineering judgment should be used in applying the 2-second maximum clearing time because there could be circumstances where an employee’s egress is inhibited. Sound engineering judgment shall include the use of code and standards, lessons learned, past experience, industry experts and peers to develop a compliant definable basis for minimizing exposure to electrical hazards.

C. Within SKM, utilize options under menu Arc Flash – Study Options > Standard and Unit; select check box “Check Upstream devices for mis-coordination” under [Upstream Mis-Coordination Options]. Apply a minimum value of 3 within field “Levels to Search”.

D. All major equipment likely to contribute energy to the system (transformers, generators, motors 25HP or greater, chillers, boilers, AHU’s, etc.) shall be verified and incorporated into the SKM one-line/model.

E. Provide an additional bus (representative only) inside the SKM model at:

i. the line-side (“source side”) lugs of the service disconnecting means (i.e. Main OCPD)

ii. the line side lugs of Switchboard/Panelboard Main OCPD (if equipment), Disconnects, ATS’s, VFD’s and UPS’s

iii. the secondary terminals of large (125kVA or larger) distribution transformers
9. **Draft Pre-Mitigation Report – Deliverables**
   
   A. Provide one (1) hard copy of the arc-flash report for review.
   
   B. Provide one (1) CD-ROM or flash-drive containing the following:
      
      i. Electronic copy of the “Project>Backup” of SKM model with all associated files.
      
      ii. Electronic copy of the exported SKM one-line diagram(s) in AutoCAD and PDF formats.
      
      iii. Electronic copy of the scaled floorplan(s) in AutoCAD and PDF formats.
      
      iv. Electronic copy of report (with all scanned or printed into PDF format). The structure of electronic file submission shall match the order and file format as described in Part 7.A of this guideline.
      
      v. Electronic copies of photographs. Photographs shall be provided pre-sorted and in a folder-file structure grouped by building and then by panel/equipment designation.

10. **Final Pre-Mitigation Report – Deliverables**

    A. Provide one (1) hard copy of the arc-flash report for review that incorporates comments/corrections/direction from Duke FMD review of draft report.

   B. One (1) CD-ROM or flash-drive containing the following:
      
      i. Electronic copy of the “Project>Backup” of SKM model with all associated files.
      
      ii. Electronic copy of the exported SKM one-line diagram(s) in AutoCAD and PDF formats.
      
      iii. Electronic copy of the scaled floorplan(s) in AutoCAD and PDF formats.
      
      iv. Electronic copy of report (with all scanned or printed into PDF format). The structure of electronic file submission shall match the order and file format as described in Part 7.A of this guideline.
11. **As-Built Post-Mitigation – Deliverables**

Once FMD/DUES has provided final comment and direction regarding Recommended Remediation and all Remediation has been completed, the report & model shall be updated and the following items shall be provided:

A. Provide one (1) hard copy of the arc-flash report.

B. Provide one (1) CD-ROM or flash-drive containing the following:
   
   i. Electronic copy of the “Project>Backup” of the SKM model with all associated files.
   
   ii. Electronic copy of the exported SKM one-line diagram(s) in AutoCAD and PDF formats.
   
   iii. Electronic copy of the scaled floorplan(s) in AutoCAD and PDF formats.
   
   iv. Electronic copy of report (with all scanned or printed into PDF format). The structure of electronic file submission shall match the order and file format as described in Part 7.A of this guideline.
Figure A: Label Examples

**WARNING**

Arc Flash and Shock Risk

<table>
<thead>
<tr>
<th>Appropriate PPE Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flash Hazard Boundary</td>
</tr>
<tr>
<td>Flash Hazard at 18 in</td>
</tr>
<tr>
<td>Available Fault Current (Isc)</td>
</tr>
<tr>
<td>Shock Hazard when cover is removed</td>
</tr>
<tr>
<td>Glove Class</td>
</tr>
<tr>
<td>Limited Approach</td>
</tr>
<tr>
<td>Restricted Approach</td>
</tr>
</tbody>
</table>

Panel: PNL-E401

Bldg#: 7731  Prepared on: 05/13/15  By: B. Jordan

Warning: Changes in settings or configuration will invalidate the calculated values and PPE requirements

Figure 1. Example label for PPE Levels 0 through 4; **Avery 6878**

**DANGER**

NO SAFE PPE EXISTS

ENERGIZED WORK PROHIBITED

| 156 in Flash Hazard Boundary |
| 41 cal/cm^2 Flash Hazard at 18 in |
| Dangerous! Available Fault Current (Isc) |
| 10.44 kA Shock Hazard when cover is removed |
| 480 VAC Glove Class |
| 00 Limited Approach |
| 42 in Restricted Approach  Prepared by: FMD (B. Jordan) |
| 12 in  Prepared on: 05/13/15 |

Panel: SWBD-MAIN-LINE (Electri)  Bldg#: 7731

Figure 2. Example label for PPE Level DANGEROUS!; **Avery 5265**
Figure B: **Typical SKM One-line Datablock Formats**

All component types shall include their Component Name on both input and output one lines.

**Create and name** the Datablock Formats as listed below.

<table>
<thead>
<tr>
<th>Component Type</th>
<th>Input Data - Displayed Attributes (Attribute Template)</th>
<th>Output Data - Displayed Attributes (Attribute Template)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Datablock Format Name</strong></td>
<td>“Duke University – Input”</td>
<td>“Duke University – Output”</td>
</tr>
<tr>
<td><strong>Bus</strong></td>
<td>SystemNominalVoltage (%1 %2)</td>
<td>AF_IncidentEnergy (%1 %2 %a)</td>
</tr>
<tr>
<td></td>
<td>ContinuousRating (%1 %2)</td>
<td>AF_WorkingDistance (@ %1 %2)</td>
</tr>
<tr>
<td></td>
<td>ShortCircuitRating (%1 %2)</td>
<td>AF_PPE Category (PPE Level %1 %2)</td>
</tr>
<tr>
<td></td>
<td>Description (Loc./Room: %1 %2)</td>
<td>AF_Boundary (AF_Boundary %1 %2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>InitSymRMS 3P (Isc 3P %1 %2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description (Loc./Room: %1 %2)</td>
</tr>
<tr>
<td><strong>Cable</strong></td>
<td>CableSize (%1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>QtyPerPhase (%1 %2 /Ph)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Length (Length %1 %2)</td>
<td></td>
</tr>
<tr>
<td><strong>2-Winding Transformer</strong></td>
<td>Nominal kVA (%1 %2)</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Z% (Z% %1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SystemNominalVoltage (Pri. %1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SystemNominalVoltageSecondary (Sec. %1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>X/R (X/R %1 %2)</td>
<td></td>
</tr>
<tr>
<td><strong>Utility</strong></td>
<td>SC Contribution 3P (SC Contribution 3P %1 %2)</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>X/R 3P (X/R 3P %1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SC Contribution SLG (SC Contribution SLG %1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>X/R SLG (X/R SLG %1 %2)</td>
<td></td>
</tr>
<tr>
<td><strong>Generator</strong></td>
<td>SystemNominalVoltage (%1 %2)</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>RatedSize (%1.1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>InitSymRMS 3P (Isc 3P %1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>InitSymRMS SLG (Isc SLG %1 %2)</td>
<td></td>
</tr>
<tr>
<td><strong>Induction Motor</strong></td>
<td>Rated HP (%1 %2)</td>
<td>Description (Loc./Room: %1 %2)</td>
</tr>
<tr>
<td>(&gt;25 HP)</td>
<td>Description (Loc./Room: %1 %2)</td>
<td></td>
</tr>
<tr>
<td><strong>Synchronous Motor</strong></td>
<td>Rated HP (%1 %2)</td>
<td>Description (Loc./Room: %1 %2)</td>
</tr>
<tr>
<td>(&gt;25 HP)</td>
<td>Description (Loc./Room: %1 %2)</td>
<td></td>
</tr>
<tr>
<td><strong>Protective Device /</strong></td>
<td>Frame/Model (%1 %2)</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Switch</strong></td>
<td>Sensor/Trip (%1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>InterruptingRating (%1 %2)</td>
<td></td>
</tr>
<tr>
<td><strong>Auto-Transfer Switch</strong></td>
<td>Amps Rating (%1 %2)</td>
<td>InitSymRMS 3P (Isc 3P %1 %2)</td>
</tr>
<tr>
<td></td>
<td>Withstand Sym kA (%1.1 %2)</td>
<td>Description (Loc./Room: %1 %2)</td>
</tr>
<tr>
<td></td>
<td>Description (Loc./Room: %1 %2)</td>
<td></td>
</tr>
<tr>
<td><strong>UPS</strong></td>
<td>SystemNominalVoltage (Pri. %1 %2)</td>
<td>Description (Loc./Room: %1 %2)</td>
</tr>
<tr>
<td></td>
<td>SystemNominalVoltageLoad (Sec. %1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>UPS Rating (UPS Rating %1 %2kVA)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Description (Loc./Room: %1 %2)</td>
<td></td>
</tr>
<tr>
<td><strong>Motor Controller</strong></td>
<td>Rated Size (Rated Size %1 %2)</td>
<td>Description (Loc./Room: %1 %2)</td>
</tr>
<tr>
<td>(VFD)</td>
<td>Rated Voltage (Rated Voltage %1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ampacity (Ampacity %1 %2)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Description (Loc./Room: %1 %2)</td>
<td></td>
</tr>
</tbody>
</table>
Figure C: Duke University SKM nomenclature guideline

Below represents typical nomenclature to be used in all SKM models.
Figure D-1: Typical Input One-line

Utility transformer to be omitted from Building model in the presence of a High Voltage Study giving the exact utility input at the secondary lugs (provided by Duke FMD)
Utility transformer to be omitted from Building model in the presence of a High Voltage Study giving the exact utility input at the secondary lugs (provided by Duke FMD)